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Windows 7 Start menu.
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Run command{Wlndows key + R}.

$d 3> gluislwl (5o J9)lS hg> dl g3 lgad HuSuS 5 35leS(())) olgl> o

7 592039 3.5 Ju (530S dgSuliiuing€ 0y 9lg)lS 4y gigaileS 3 95 )

aSo3 4y a5 wileS ) 3 Iy (sallilwl)aslol (s)91 0)) @ 92 )b Yol

S (5959 02l 5 90l 2 YuSo Vi Jlgan 92 3 455,130 9l (595 )1

glguod> gl.y9i gl )99 (Aighle liwl (digol)Sg a8 ¢iyg Hlu

© 95 {5259 SlS (531 giso o b giwo )liww g0l 2 S 2.0,
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1: Open the start Menu in then the Run optlon and the.

cllck

Help and Support

nnnnnnnnnnn

Programs and Features appwiz.cpl
rRegion and Language intl.cpl
Admenistrative Took controd admintools
Registry Editor gedit
e ACrODST (F MElaleg
Remote Access Phonebook rasphone
Adobe ( e o}
| Remote Desktop Connection mslsc
Ohe Mled ) ol
AASDs 1m.a-gtie.hd'1- [ it alad ) imageready RGS{}UIEE Mﬂﬂllﬂl’ rrrrrr
AZODE PROEOEROD (I il el phtogR™OD SAM LD‘Ek TDGI SYSkEY
Screen Resolution desk.cpl
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How To Restore Run Command In Windows 7.
/ yodidg 3 gl dS.0g (525 d) 6l> d<) o)Ll USW (122)0)qu0 50 Q

9 9wl (59 ($25)9 dwd d )Ll JlaS () 39) dub 3 S gine Hliw
o)l 9Jo) Ly 3 (2 9uwli > 45 42 Joi -£6)S Jlw 0y Lilwl 4y 1y £,
"WleS Olg)" 3 S 505 T9deS 1399 gine J 27 3 £y L)l 45 glgS
S (3B AgolS Lluadi .¢5)S 0)9¢ Ll
1:Right click on Start menu and select Properties
2:Switch to Start Menu tab and click on Customize...;

Opens Customize Start Menu window.
3:Scroll down a bit till you find the option Run Command

and select it by ticking the check box.
4:That’s all. Now you will find the option Run... in Windows

/ start menumenu 5-(?)don't search.

09S do (Hoi W 15 g3 (S9plg dode A (§35L Huml Aes @) guoli > S )
k> b 0y ol 0sdd ol S 40p) 4 ol B @) (5xS9 Hedd 2 ($BeS i
Sol ($392 95 oly 09l ($93 90l 2 ISy 95> (53 & Hlivgy WleS
S$9S U U Gl

6-Search with public folders

CLoLc.)d.)|Jy69ﬂguﬂ£duu6xbuuu|d£JM9wbu>dK)b

{62359 V94 0w (S)M g8
/-Search without public folders.

d.oLCCUdJ).JClJ|39J69)J9dn)l£¢uudxbu;w|d£.)d)9wbu>d15}h
(5259 9d) 9))g8

o Taskbar and Start Menu Properties ﬁ

Taskbar | StartMenu | Toobars

To customize how Inks, icons, and menus ook and Cus
behave in the Start menu, cick Customize. ' Eg '

Power button action: |Shut down

Page 208




How to create run shortcut on desktop in windows 7

1:First, right-click an empty area on the desktop and go to
New > Shortcut to open the Create Shortcut wizard
G oS Syl <eei ol x50 SlS i S B JB o S olias 4 (g0

S dxdrcaly 3339 oS Dyl 3 9335 i 4
2:Now for the important part. Copy and past the following

path Iinto the location field as shown In the screenshot
below d.‘S.JL_;_uﬁuSd}Lu C8ga o .03y ng-yun@o_suugl

cds Josas S Ol (xS gaid > 4Kt oS0 S IS
C:\Windows\explorer.exe shell:::{2559a1f3-21d7-11d4-

bdaf-00c04f60b9f0} C: drive name.
3:Then name your shortcut to “Run”, click Finish, and close

out of the wizard. On your desktop you’ll see the new
shortcut you created - test it to make sure it works
33 33393 9l iexS9 SIS S s gSie pst oy W eSS oola L L
Mbeéasseuswuéymgwbwéuwdwww .9
ssS 5 1 S 55 awdyioly 9343 650 aryg0)l 13 = o)S audaal

What item would you like to create a shortcut for?

This wizard helps you to create shortcuts to local or network programs, files, folders, computers, or

nt
Iype the location of the item;
A\Windows\explorer.exe shell::{2559a1f3-21d7-11d4-bdaf-00c04f60b9F0} Browse... i

Check Next to continue. 2

oroovvPost.com

d )wbs-' SAlS CalyeSse ool S ool > 61195 9A‘J dSJ)L\M

S (59 99 30 s g3

| 1.GUI(Graph|cal User Interface).

Select an icon from the list below:

W, BN & 99S @J‘LSLHMQ_)ngg)ﬂng-}QQLAOJH LS

1=10Q ImE P
‘e ewre | 2. CLI(Character userinterface).

- CITEN 63 pl s oS gyd d gaug b b gy9Y
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CMD{Command Prompt or Windows Command Processor.

or cmd.exe}.
w3 45 gigaileS gib) ax> 280 d Cuely dileS 5 S jedig 4
93 3iLeS 3 515 p 9Bl jeaing SudLS 3 digailaS Iy . (56 giaz
S35 o) o)l 9gS 0)u)d 92 i Sildes iu> 3 43S laz)s
LJS JUB 1993-1987 ¢y ColwgySule @ gl.gg)lS g (599 y90 O

oJoS 0 a3 ($353 ()l sy gl 99 =1 9igpol ¢ligis 31395 H945
9l 9J9S J> ($)igiw gluno jodidg Jood (x> 3 15 . (345 Jo)lS o)L
ogolyy 33LaS 3 4555 4 Jlin 3., (5365 JolS e o)l slgS Jo
S Jod 6635 R G 4 ) M99 alie (595)3 0)>] &5 guwli digaileS
Uigolew 4 939)igusnS 9)90 «5)S Wl Sw Uighle Jus (¢6)S Guno)lo
1D Gaaolpy JleS 5. a5 09 )98 9l «£6)S Jw W HigaueS Ju> (Esgiumls
) O (b WigSad ol igl
dgdileS Sl ./7.8.10 11)99“-’94-’u>u“’°9-’u>°~3w 3.0
> CMD 98/95 )9 Q d.) 9| Lg).a.SJ.lJ ng,,\JLAS wlp ,\JLoS L\ ,\J[AS
9| MS-DOS 1 ng.o\JLAS uS DOS d.J dg.g 1 )9.0 L.S)-’-)L’ ‘99.) ClJ 9.)9.0&)[405
UJLLLQ&Q»WUJLLLQ.CJp)JLgJLgASJ.oLuUSWLSJ

($5259 diwyo S o3gud gigigly gigailaS 3 & @i
How to Open Command Prompt (Windows 7)

1:0pen the Start Menu, 2:Go to All Programs > Accessorles.
> Choose Command Prompt from the list of programs.

B cmd
Files (12

iin -
e

@ Administrator: C\Windows\System32\cmd.exe =

% Snipping Tool

Lite T .

See more
@ ( p— 1. Click the Start Button '
- _ ‘

Back

Shut down
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CMD:Chief Managing Director.

58S (G929 39995 ($9 pl w15 S 10 jgning 4 9l 7 joaing 4y L

4 s CMD (5)) oy (S9ldrg (593 9l (S9li)SSE (593 S Windows
10 s 0> (548 Lol e 0y oilogleo 0)U )29 (590 3 (Sl SI gl
b=l Jga 32 S yiguuaS 4 gunlivn i oS oy dilaS 5 > 00
wbSuﬂbw"dJ}uyegSUSM >l 5 S MgaaeS ) gwliw o 69-l>
)3 30 (5)S dod> dagdiuns b Syly (59 pl Gw sl Lz dS Ho 95*1 s
G2 (595 U)HLS AigagS 12 o) 9lguod> oo adino 4 gli(S9 2 55
$)B (S 83594 J)S)9 (2 U ginlad 13 diyg i 0)g) ASE s yu>
3:9)S9 0)uw)g Wb ddy)b des 95> b LlgodS (59 g gl > S
S oSy 09 3 1453 ()3 (530 L £6)S9 SUlS LT )l jaig CMO
Q uSgbbuggo Lgﬁwbcmdwpmagléﬁg&b'uudxb
LSS Ggolyy 23LaS 5y 15.65)S 0)9€ (Hgiuninodl pul O J91> ngJ

gy ™ T CMD command's information.

aaaaaaaaaaaaa Mode 80.

ccaroni LoM> Ao b gaizg (59 pl Lw gl > dS)
— ' O ol Lo ol,ddSidg wbd*idcb)g.) 13 ¢) 0)S
L 9229 (59 pl L 3 U guwliw A W5leS 15 93 ¢899
Q) 9> 0 (§39 Ga€ gl HizgS Jlg>y s

5905 b gl (59 Db 0095 9wl 3 0)lauds (5)5
0) S oy O liSiuny 15 99@9 &G gwli U 6109300

W Vel S9S
£ 8
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Color Oa.
93 299 O 20 W 9l 5899 S5 (59 pl L ) MlaS 4es gl > Sy
LﬁJ)u*SJJ9|,\J9)§.¢JUWL§QP|UAJ)9MULSJJb)JLQSL§JdJ
6xb L,Jngm).Lpl)gJ-.Sq.ng,ul) Lg_mb S (.slumgfm)le ol Lg).d_n
99 (2 Liwg)g 52 (595
{O0-7}.
S 420 (5y4S o3laiwl 0)ld o b Mig)Sw (59 al Lw 0315 905 b oo
SHN S5)  259)Sw (S pl L D 9 (89 90l 0)loud day 9>
{a-f}.
LJJ?&)Q-’HWLSQ(MUN|3u>u*563959wu°%”999)>63q-’
u-m9Lr°9S9-“’bu59-99)->9-C-‘9>d-’45m6)5
¢+ Command Prompt CO'_O[‘ /?
Al w4 JleS 4 guwli > S o
© 95 {299 Ui B L ol &899 S (59
Jgjd_\"g.wb"d.)o).a.ud,ﬁulé.)
2l 4593 990 digdgy> by (SHloud 0sS 1s daS) (5)S 0)ISuis )3 Wileglas
6§o)&uubglaodggm)9pd»6bdggd9)o§
{/?}.
ALy 0w JileS )@ dS 490 (5uS oslaiwl 0)ld o s MleS 5 Gluawl 1

S25)3 i JileS A2 |5 (259 pgd WS 15 1L S juw @ o>

G L2 2+ 201 L7290 L/7D) L/Z7E2ON & Z7E:OFF) L/7F:0N
L I R string

s pec i f
Pt

vl by strring ani
vl hy =1 1*i1|-| 11
i:' - P

.T' ) iur;

ol dwgl (polud 45 2ig) Ju> ol duwgl Hug>
095 )58l (535hy 93)S 94iz9S oli>
03 0)3 09 i 9lgS L) olud (59)5 9l 93)S g29) 0315 4SS
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CMD enter press Help.

3 95 &899 O 2B W gl (099 Lol S ol JlaS @) gl > dS )0
LSJJLDQQJJJU}L;J WS (59 Plu#’ L Cuoly ,\JLQS.),}J‘.ASUMU).D
) £ oS 9l 534S Jo)lS 0yl 9JoS giaz giloglen gy93 3 0yl 4
)93 0)l 4y S )3 9l 9lg) 1S WileS 3 9355 {59,859 MleS iwwpe 3 S g

99) >l Lalido (63 3 gl ($)) Ogiw dig)lid>l pgS dSJ {6)S 03) Diloglas
S9 pl w . ngJo,\JJdJUJ.QJLg)SP.Lb.udSJ;,MLQSL.Q_ngo)Ung)LS
u5 O)U bgdilaS Joi a2 | LS)J O9iw BigdileS pgS (S Gl MleS b

5953 Dloglao

CMD enter press Cls.
)GS (9 pl w4 guli > dS 0
1> 93 E5009 i )il Lo ol LSg (Gl ol
ol 2SS b (59 al w 3 gwliw @

25 Sy dgi & Sy (S 3 S

——— CMD enter press.

g;g[z’]r A A Dir/s.
- u.u.)d.) g.u)lJ u><?l-l5)-Q
< > | e

(LS <enter (ol ikas 1 (5903
0SS Gagolyy 2loS @) guolivw @ 15 65 £5099 i i L ol 299
O u“’LJQ)HSCUU>LS)J)39‘DU>U>|)¢*S“JLJJ|9)J999JUSW
T o slaanala: (SH)I9 D 0)uw 9ldg

BN C\ w\s
Microzoel t Window lUe ) von | 4

SCl‘B@_ﬂ”

- I m & Sl hE ~um &n s fam I = $
lllllllllllll

HHHHHHHHHHH
[ ]
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1-CMD command enter press CD: change directory.

) 5299 Ui )0 L ol £5299((59 Lw) S ol JleS 4 gl > dS Ho
Moo L agi ulyy 4 Jol 9565905 45 )2gd Jy dxs )29 g3 guwlivw )
2-CMD command enter press CD... move you one level up.
25 Lo ol E5299(ST ST (59 W) S oy JilaS 4 guoli 2 alS o
o0 13 G )HNg9 S0 9wl ($3L ($3 ) 93 {5099 OB

v Command Prompt

CMD command
enter press DIR:
show the
contact

le S USu«uw'p BleS @ gl > dlS )0
,_ $3b ($3 ) 95 99 K 2B L 9l Hd990)!
o — 2139 LS )99 pgS 4 9uls > (5BgS guls
O o)L L__S-)b S 4l UL_;:J.ulgo_)g.ob9| b

5553 loglso S

CMD commana enter press CD\
move you to the root.
S o) GS ol dileS 4 guoli 2 dS y0
099 O i W ol £899(LST puw dpun Ginda
U a0 ($)>10)9) 2 (5395 guwli (3L (S Ay o

).}J9_9 |.) U.u.) ),3
CMD command enter press MD:

make directory
C:\>md myfolder 9 al) S Gl JleS 4 gl > dS )0

Y ) S Q9 H099 Ui ) L ol (299
i (b)) )0 4 45 490.5)S 19> ))9d > ($BsS
) 313 Wicrosoft Corporatien. AL1 rights reserve 9>.0) dug> guwly (59 19> O ul;S:...wg 15 b
S Jol &8 (63 (S0 oS padine 4y S
OB Bl W gl (59 al diuwg)g pgd ) @
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CMD command enter press RD: remove directory.
9 {899 O 2 W ol H299( (59 )1 S Gl S @ gwli > dS )
b a9 b 9wl 6xS SHe b iy )adgd > (39S 9ol (s33b 3 @
1 Lo 9I OS5 69 ] A LS)SW )Mg9 )9 Fro uld&u.ug
— (299 O 2B W ol pgi ) g9

CMD command enter press.
Tree:graphical representation
g,,u..ol)) ,\JL&S . g.quJ o2 CLLS).Q
O 0 Lo ol &899 (sl sl IS
o0 ($5395 9wli (S3L ($3 A 93 {5B99

QLS L Rl Jov 92 15 Lo dai (59 by b gl (59 )99 a5 (2

2o L )98 15 b (5p09) 95156 0)Suis JSi &y unand 13 b g JSi

example .dSJ L§)S)9 LlaS de ) diwg)g 9| E_S)S)g (’.39.)
C:\Tree enter button press #D:\Tree #E:\Sadidi>Tree

CMD command enter press Date: show
current date.

G gaolion 4 030 2LoS (53 4 93 E5899 Hi B L o
S$2S 0) S 05 AP ol JleS @ 70
C:\Date enter button press.

L:\N>date
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CMD command enter press time: show current time.
95 £5299 Ui ) L ol (55 »8l (L) S ol yy 3ileS @y guwli > alS o
CRVEY. L(...wb.) ,,\JLASQJ U.u.)g).) a9 U.u.‘.\glcl.) g.u.)lJCUO).uJ ,,\JLQSLS..)CU
C:\Time enter button press >

CMD command enter
press Doskey/history:
history of used commana

U Lo ol (525 »il (($)gimud/ Sawgd) S ol XilaS @y guwli > S o
9S (595 0)8uw)d Wloglen 428 guwli 0jw KileS (55 W o (899 Hi
0) b i gl 9)0) LSS b&gsﬁ}mésée'w@wby
C:\>Doskey/history # D:\>Doskey/history ELURTN

CMD command enter press Systeminfo: :
Find Info about your PC.

No2aS 3 52 0 ($395 9wl ($3L WleS (53 4
LSS99SLey yigaraS 15 aS) (5)S o) S loglao Joi
o yy) )igrsnS.ag) ol @1y puursang) NigrraS. @i
Ologleo Joi 13 4335 igeS yisssaS glisronn b

595 )8 &5 g5
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Essential Windows CMD 4ig35lS ()l CMD j9ai0g 3
Commands You Should Know ¢, 69y b gl >~

ASSOC
ATTRIB
BREAK
BCDBOOT

BCDEDIT
CACLS
CALL

CD

CHCP
CHDIR

CHKDSK
CHKNTFS
CHOICE

CIPHER

CLIP
CLS
CMD
CMDKEY

COLOR
COMP
COMPACT
CONVERT

COPY
DATE
DEFRAG
DEL

DIR

DISKCOMP
DISKCOPY

DISKPART

DOSKEY

DRIVERQUERY

ECHO

ENDLOCAL

ERASE
EXIT
EXPAND
FC

FIND
FINDSTR
FOR
FORFILES

FORMAT
FSUTIL

FTYPE
GOTO

GPRESULT
GRAFTABL

HELP
ICACLS

IF
IPCONFIG
LABEL

Displays or modifies file extension associations
Displays or changes file attributes
Sets or clears extended CTRL+C checking

Used to copy critical files to the system partition and to crate a
new system BCD store

Sets properties in boot database to control boot loading
Shows or changes access control lists (ACLs) of files
Calls a batch program from another

Shows the name of or changes to a current directory

Displays or sets the active code page number
Displays the name of or changes to the current directory

Checks a disk and displays a status report
Displays or modifies the checking of disk at boot time

Batch file command that allows users to select from a set of
options

Displays or alters the encryption of directories (files) on NTFS
partitions

Redirects output off another command to the Windows clipboard

Clears the screen
Starts a new instance of the Windows command interpreter

Creates, lists, and deletes stored user names and passwords or
credentials

Sets the default console colors
Compares the contents of two files or sets of files byte-by-byte
Displays or alters the compression of files on NTSF partitions

Converts FAT volumes to NTFS. You cannot convert the current
drive
Copies one of more files to another location

Displays or sets the date

Disk defragment accessory

Deletes one or more files

Displays a list of files and sub-directories in a directory

Compares the contents of two floppy disks
Copies the contents of one floppy disk to another

Displays or configures Disk Partition properties

Edits command lines, recalls Windows commands, and creates
macros

Displays current device driver status and properties
Displays messages, or turns commands echoing on or off
Ends localization of environment changes in a batch file
Deletes one of more files

Quits and closes the command shell

Expands compressed files

Compares two files or sets of files, and displays the differences
between them

Searches for a text string in a file or files
Searches for strings in files

Runs a specified command for each item in a set
Selects files in a folder for batch processing

Formats a disc for use with Windows
Displays or configures the file system properties

Displays or modifies file types used in file extensions associations

Directs the Windows command interpreter to a labeled line in a
batch program

Displays Group Policy Information for machine or user.

Enables Windows to display an extended character set in graphics
mode

Provides help information for Windows commands

Display, modify, backup, or restore ACLs for files and directories
Performs conditional processing in batch programs.

Displays all current TCP/IP network configuration values
Creates, changes, or deletes the volume label of a disk

MD
MKDIR
MKLINK
MODE
MORE
MOVE
NETSTAT

OPENFILES

PATH
PATHPING

PAUSE

PING
POPD

POWERCFG

PRINT
PROMPT
PUSHD
RD
RECIMG
RECOVER
REM

REN
RENAME

REPLACE
RMDIR

ROBOCOPY

SET

SETLOCAL
SETX

SFC

SC

SCHTASKS

SHIFT

SHUTDOWN

SORT
START
SUBST

SYSTEMINFO

TAKEOWN
TASKLIST
TASKKILL
TIME
TIMEOUT

TITLE
TRACERT

TREE
TYPE
VER
VERIFY

VOL

VSSADMIN

WHERE
WMIC
XCOPY

Creates a directory

Creates a directory

Creates Symbolic Links and Hard Links

Configures a system device

Displays output one screen at a time

Moves one or more files from one directory to another directory

Returns a list of currently open ports and related IP addresses

Queries, displays, or disconnects open files or files opened by
network users
Displays or sets a search path for executable files

Advanced version of ping, used If there are multiple routers
between your PC and the device you're testing
Suspends processing of a batch file

Sends a series of test packets to the specified address

Restores the previous value of the current directory saved by
PUSHD
Manages and tracks energy utilization and power consumption

Prints a text file

Changes the Windows command prompt

Saves the current directory then changes it

Removes a directory

Configures the custom Windows recovery image

Recovers readable information from a bad or defective disk
Designates comments (remarks) in batch files

Renames a file or files

Renames a file or files

Replaces files
Removes a directory

Advanced utility to copy files and directory trees

Displays, sets, or removes environment variables for current
session

Begins localization of environment changes in a batch file

Sets environment variables

Finds corrupt/missing files, replaces them with cached copies
Displays or configures services (background processes)
Schedules commands and programs to run on a computer

Shifts the position of replaceable parameters in batch files

Allows proper local or remote shutdown of machine

Sorts input

Starts a separate window to run a specified programs or command

Associates a path with a drive letter
Displays machine specific properties and configuration

Allows an administrator to take ownership of a file
Displays all currently running tasks including services
Kill running process or applications

Displays or sets the system time

Pauses the command processor for the specified number of
seconds

Sets the window title for a CMD.EXE session

Returns information about each step in the route between your PC
and the target

Graphically displays the directory structure of a drove or path
Displays the contents of a text file
Displays the Windows version

Tells Windows whether or verify that your files are written
correctly to a disk

Displays a disk volume label and serial number

Volume Shadow Copy Service administration tool

Displays the locations of files that match a search pattern
Displays WMI information inside interactive command shell
Copies files and directory trees

03 U 990) )93 (SH LgaileS W) 12 (59 pl Lw
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" 1:GUI(Graphical User Interface).
Wayu&:gl..w o985 i Sildes 3 Gulwly Susl)S s
b 033 iS5 59)1S Syg0 9l gine « Uggund 0yl 9lgS 0)lol Jolai 5 0y
(0, 9JgS diSubs gie b 9JoS SIS (4911 3) ()3 A guivg

2:CLI(Character user interface)or CMD

CUIS b ((SSghuini) puad)il SSg) S (Camasui SSgr9) J9))iS)S 5

S 03 0)3 093 (S5 JIIw @d pgd A )5l S5g)lS (3 dileS

0) > 43 999y IS |3 . uusig aSu)l ) oLy YigasaS 5 b oS LSig) S

BlaS 5 2 525 )le wwpébowﬁsyﬂuwéycsﬁ)g

oguod> 39.0)3 b Jald 5 2 pgS &5 dolipy « (58 3w o2 pgd 4y (o3

2 89 pl w40 (63 d gaing b 2o ()95 (S3uS 45 )0 ju &

929 02 )93 p 9l 199 y90 S0
What Is The Difference
Between GUI And CUI?

KEY POINTS OF GUI.

g Al 0pun Su91)S 5 (2 ($95)9 0) > 4 95599, GUI
GUI 5 CUI (5 dilwl ddiyp @

GUI (59,18 dewg oJgS o)Ll (Jr 2gS b Syg0 «9)9448

GUI (63 Cud ey

GUI sy L)l &5 Lbasls
GUI (o3 (Sigio Colagil )
GUI (g3 0392 |Hg>

L )89 gl gigac gl giMSuiio ) 153)85 2 (59 52 Lwld 8 S )9S Ko
A9 Cdgano 40 91 )0 90l 2 poS s o) (S93lo J>uS> )€
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KEY POINTS OF CUI.

CUI )Sg Jolai 0)uw gigrol 5 2 (5959 0) > i 95599, 8™
3 1 GUI (g5 (o pigiw dliy du* CUI' (59,58 3)9u5 (s)lo0*
> CUI 53 39) cagpun® CUI 5)) L)l 5 Jasdls %

CUl S LSgie Wlhasil JJ* CUI (g5 )9 pamasi 57
929 S Sghil) 4 Dlogles ygi o

Open the CMD properties.
ol Lg.\.ib ,\JLQSLg,)‘ledeng@dJS}Q
e 3L uiohyey 4 bl 33 L 9d (5259 SulS
b ol 2igySw 59 ol u S 52 oW ($295 9wl S huibg) 459 SulS
O )3 g3 sl g $2S U 031361 2 b gles)S Jn ) ‘U999}>

b | - 0 (S35
. 1-1: Option and{cursor size}.
"“ | 1-2:(?) small.
| dode S)lo SuF 533L (il (63 4 gl > S ya
1 owee b S 6 gl 4y oy il (53 4 65 (S99
S Fop ©lSuuw) 4y (595 )1 JSub izgS ) jig
(?) Medium.

Properties [2]

dode S)lo i (53 iyl (69 4y gaoli Lz 4IS 50

o ) iing) uge b yu)S 45 gunli 4 o) (il (53 ) 99 (Sols

3L Fop OliSimy 4 (59518 JSib 4 e
(?) Large .

Liqksxbu;wlé.)d.)gmbydls)m

Q) 00 iy «_s'ocb 9 (S9M9 dode S)lo

4 > Gaf @ pigy Yo b uw)S & gl

S Foy OliSun) 4 (595 )18 JSis
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1-3:Command history.

AL BgaileS Gl 2 ($95)9 02l 5 S99yl (2 03 LSS 0 1
23S Ju W ol a0y

1-4:Edit option.
0wl 93 (59x)9 dode S)lo S (535b Hlidnl 9loi 9€0 4y guwli 2 dS )
)99 L ol Joag2> )Me9 a8 (6359 )15y S ($9 pl L 4 2 W (S35
G L 9l JoS (2B b gl JoS o Wlegles S )Mgo b gl JgS bsd
‘U)-O S 9I 52553 0)>l 4 45 95 JoS )18 S GigailaS )i wls ol JoS
FEled 595 4 )lS ) 0iS1 93 0)S (5)) dode S)lo S 90

2:CMD properties{font}.
P'uw|3u>u*UL539S9-u’bL5-\-’bu-“U|L5-‘d-’
93999)> b Sl 051l ba> by S gy (59
02 QB (65 4 (595 151295 L 9l (§9 Gl (2 0)1
o B4

3. CMD propertiesi{Layout;

OK Cancel

d o b gaing oy VleS 1 2 b (5395 9wl ($3L Gl (55 4
i (5365 i8S L o dlwwébdo(w

4. CMD properties{Colors}
IouSg,wgcuw).»,\JloSlsyumksﬂgngbngbw.ulkgocb
uwl-‘9|6)SLJJ‘JLSJ)u>‘Mb9M9LSv‘€|uM’|39| $3S Jn Sy S
A = | .J9J->~J 49S5) )9

rrﬂlhhl|!FM|ll|U

SSSSSS 0-01-99 5:00a

- it C:\WINDOMWS> dar
e \WI NDOWS> d"' | | SYSTEM <DIR> 10-01-99 5:00a
st SYSTEM <DIR> 10-01-99 5:00a

SYST EM

—_— — -

. OK || Concel

Page 220
2 9Qs




Notepad.

SN (59 e ldac 4y (dSei 4y (S 3 (53 e i 3 ) Dy
o 3 i oS 1 6}Jomu59195ww|uw°->hwu>°->
g S A diglSuly Cuwlio 9 (o).w&‘.wg.; agd Jalo ») S oMl dighls
150)S 0)u>3 gl (6259 SO US Lavg> s 1o gl.dighlo SH glidighls
how to open Notepad in Windows 7 JS ay Jlo
1: Searching for Notepad* 2: Using the Windows Menu
3: Creating a New Text Document* 4: How to Open
Notepad from Command Prompt I Wmdows /

=yredf 1z

1. Type notepad and press Enter Button

| Shut down »

Petonslize

' 1. Click the Start Button [
e 't —

Open the Notepad properties.
 ly (353 L gl (5259 SUlS Gl (s30b 2w gi guwli > dS yo
o2 LoN> @ 99 Juidl)ey i 13 93 £6)Se SIS (533b juislyen
9.> 9 9| O)l.u.)| L5)|9-’ dd ) ) 99 u-l-’9 US d>.0 (163 159)'21.& )g.o

i e Cs 'H_L . :
samplel.codid Properties ' Permissions for note pad X 9J. u 9-J oo 9
y  Genenal ’

secuty Dwelals Frevious Versons
Securty
g d
Obsect name:. C\Windows ' notepad exe
’ ' Type of fie SOFD Fie | cadid)
‘ o ~ Group or user names
i wWilh - Cx 3N D0
it Bl e Ooge.- | 5 ALL APPLICATION PACKAGES I h e
2 Lo ahon C ' Uyers Degkton Mew fokder (4] h!- SYSTEM
B - i e AL Administrators (WIN-UCBDSNG 7E 1H \Adminustrators)
SR Users (WIN-UCBDSNG 7E 1H\Lisers s -
Seeondek: 560 KB (57 3dd bytes "
\ B2 Tstedrotsir invention o
Crestec 16 Jaruary 2021, 13:18:22
Modrec 16 January 2021, 18 45 54 Add
"R — t h e nNote ad
P - Permissions or Admersstrators Abow Denyy
’ Anrbotes | |Resdorly [ | Hdden Advancad ' —
' Ful control - [ ]
\ 2 Modfy ¥ J
Read 4 sxacite 1 [ ]
Head ] L
Cance Wite M [ ]

Y aIVEg ISVERGITY
S 1983 4415 9l 9 (625 192 (SI90 ) S L) Ghol 3 dn Dgd
o> BS S0 Jo)lS 0w i SSldec joxig 3 al)Sen 15 .0 Hou>
) 3 2wy Wgi xSo (5 dine CdlwgyHle Sigye> alxSex (53 3 Joi
{Richard Brodie} oD 19> g (SI90-
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A:What means notepad?

2 9L LI 0 0yl olSid 9igigh 310938 ()] Lige 45 dw Do)
noun. a pad of blank pages for writing notes.
1:What are the 4 menus of a Notepad?
File, Edit, Format, View, and Help
2:What are the five parts of a Notepad?
Quick access toolbar, Title bar, Ribbon, Text area, Status
par, Wordpad button, Scroll bar, Ruler
3:What Is the size of a Notepad?

The most popular standard size notepad Is 5.5 X 8.5 Inches,
followed by 4.25 x 5.5 inches, then 8.5 x 11 inches.

4:How many menus are there in Notepad?
Notepad has three bars, Title bar, Menu bar and Status

par. v Menu bar contains File, Edit and Format tab
5: Notepad Definition!

5 9l (53 )l e 03lw o3 0yl j9ding olwg)Sale 3 d gi Iy
g3liwl 3 45 9S599)5 yigaraS 3 2 03 Aol Hpeg) 819S Euo)i (yin
$95)9 Olgd 9lgS diuisol,).

6:How many sheets does a Notepad have?
>l SHleo 0)w > b digiud 90 AelS (sacle 5 ap g0

~ 7:What s NE)tepad another name for?

391l ()92 i gi 3 DLeslyin 0)ld iy Dgi 1o b digegi Hoi i g3
9310, il a5:9,)S63:4,53:3,090 Carili 28 512,007 L,q.lS
9|«0).)))US O )l 111, diing) 10, uex)bi9,3¢ 518, 0 g3t/ So)
o S 13 z0)Sw12,(ph) S ) LSSl 4

Untitled - Notepad
File fdr Format Yeew Help T
T Title bar

vienbar 9"L_$:)‘:':S 0)9) gl )9 o QLE» 1D Lg.)ub G 9.l_;_> P
€SS 0)g) digilo)l 0y) 15 (650 guus 4 )X |o
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/:What is Notepad another name for?
1:block,2:jotter,3:memorandum,4.:notebook,5:notepad,6:p
aper,/:parchment,8:quire,9:ream,10:scratch,l11:scratch

pad,12:slips,13:scrap paper
What are the parts of Notepad in computer?

1:Title bar.
S edl (50 ) Gad Sdyw dolip 3 s (dpwg (5)leo b Hb) S yuw 5
b i 9195 (5399 9l 8oS (551l Lo / 9JgS alaclt glgaS 3 gl (aw g
o)l ) Sy> )8 3 i oS 9l 59 6 abacl S8 4S5y (5
6525 S ol SlS 5l S puw
2: Menu bar.
03w 9 0)uw G 3930 93g) >l 6loS Coml e 5 4 9wl )b gine
939) il gino 3 0)ld iwyo gl ) iy Gl (b8 5 .5)9S9 (xS
5953 Wiy
3: Program control window(captain button).

L SH9 Lol (izeS b di€ 9ing 2 b (595 9wl (S il (53 4

4:Status Bar. ($2S 23
B2 Mz L (Spead @S 3 gl du)S gl )b S 2 Dgd joaing
o.lext Area. SH 2990 gl juw)S

LS)‘S Jg)lS O)Lo.l 9.|95 g.a.)l.g (0 D 1. LS)J ug.a.uu Lg.\.lﬁ )L) QILO D 15
6: insertion point.

wdodJthngblao 03 S Jb 4 9JeS5) 50 (S aalw 4y (Hie s 1y
ngonggswd.idl}(.\gs.)u:_o)l5|..)u.>09L59.w0)lSuJ
/. Scroll bar.

— S i soliw Goizg 3 Juies |
Hlu Bar RRSTS— w o IB CU)Q Cl.))g U‘> )..lJ.LuJ 9.) US
—— wonar D bl uo o> (JoSHIS

| S J9S JorSuw )9
ik, R
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Open the Notepad program and File menu{ALT+F}.
1-1: New or {CTRL + N}.
605 o> A G b g 9)9 I g AS) digol)Sgy agS gunli > AlS
J 9| ng.;o)l} Cl..;b L:,JL> Cl.,)l.! S L g dg,) Ci.ul.og_\l L el)Sg).) |
S OB Sy 3 (2 9wl 2 (83 09 ped W 3 L Sidyuw (2 IR (89
)lSJ d.;l_»ulb QdeﬂégJodegwngo)JdJJdS £ )]
¢3S Jlagiw! JleS (sgi @ wbyao.)
1-2: New window
S 39 02 4 S QU cd > 4 G S 9wl o 4y 5leS (69
95 09 0w 6)gS S dy 4 oS 5wl ¢5)S J> dgaw Cgi 092
XS Jz b9 92 ) gy
1-3: Open{CTRL + O}.
b GaiogS1y 3 0)ld 6JgS (53595 3 (5x09) 53431 3 D19 61915 5 MilaS 5
1-4: Save«CTRL + S». o)l gJgod5> slw
g 3 guliw L3 dSis)S Cawo b (63595 S ) g ) 9lg) 5 3 JleS 5
5 0)ld 8lgS (saie> a8 3 (s)) uwdﬁ)UOMJJUJuSMb)JM
6525 s3e> 5 (5p08) 9l £5)S dwdyi o (595 4S . u (534S J9)lS dileS
'o\")ScULS)SLS'”PLU9|L>S‘*J9LJ99P9JJJDM')USU**SJ(°9JJJDJ
293 13 ) 9wl > £5)S (SNe> agi Jald (595 d8d 3 @ 13 .¢5)Sg S

2| *Untitled - Notepad | )S L.A) U
File Edit Format View Help | ) Documents » _Digital Citizen 1
. - P Extra info 93 gl 4> as gl
1-2 New Window Ctrl+ Shift+N yougl Y e g ”', | 3 > TR T og:Sl A1 & sl
1-3 Open... Ctrl+ O 9J > Ls { " t)}
iSave ) Ctrl+ S LSJ-’L‘ u.u.t.ﬂ ULLSJJ..UQ o8 uS Co>g
Save As... Ctri«Shift+5S

—— f b ol (55 ol €S sunlian 95 £5)Sa LSl

Print... Ctri+P ﬁHmF;m} fnco CU |) 9.J L59 L1A-J-09S|'u) b 9‘ L59 ),;J9_9

- 4 S 4 (S0l b @ Fop oS
ubduld.b)gkgl:)_xi)d)bglwgﬂ,)d.)L)9|g,J9J9,)dJCL59|U.ww

UMMUQJUSLSBQLLMQJLS)S
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1-9: Save As.
JN B 9 S 420 4 9l (6)S o> o (59 192> (S209) g0l > dlS
6535 J» o Llol (sg4s disnizol) lg] glinw 2 (5)l9€ gl ol &5)S
4Sg5 ) )18 5 s oS 9wl 95 £5)S (sig> Jald (95 92 Jod S o

9195 995 9l J9o (5599 3 «pgd 219 3 93ghalo (§ou (339> 3. .{5)S (39>
1-6: Page Setup. Lo saS Jodv s @

o3 lg3) 9198 @alais 3 il > WS 9JgS Ealail 3 il 5 S g3 4
w&dﬂulwadeLﬂSngSngbwdeu;ba (SHS
¢O)|.\J|U.,)Lt.\ asJ u»dgf@hudbdgwbydpé)wb

Uml_g.nSL_a_u)J 13 13399 ol S yw du.ubugb_) u.u.z.q.u)glu.gb
1-6-1: Size.

0312l u,gb LJ,ag,S 3 9wl ({5)S 0)93 0)l3] 9> U.,)l.) 3 9wl S Gl Sd 4
1-6-2: Orientation. &35 il Ad oy

AL 3 gwliw E5)lee il Joo poS gl 2 03 Giso (S L)) b
0w ¢JgS Wl gl b J9S ol g9 g 0)kaie b 1950 gl ool
1-6-3: Margin. (51959 S LiS>e 4

3 Rl Gayle G S5 9gS B 4 55 S lgs gl 4 duo 5
Byg 42 (5303 S poS S 450 LRAB Q) 95 iS)e) L (S GIb

J99 J99 (53 3 LS 92l dedl> 4y il 3 LS o Wigi 4 . Rlg 2o
1-6-4: Header & Foofter. 6xS eudais

B2 O 420 S Salpuw ) 9l (§9 )99 9lod ) Sdpuw GIb S — Sy
D S 20 ) Gl 3 LI (LS By Sy 3 LIl Gie 3 (53 (e JSU
IS > e poS S 2igd ) gl 03 (5353 olgi 5 il »igd — xigd* (59
694JL5—\33L>4UJuwu-‘by»ﬁddbuwémédhsw

*Untitled - Notepad "
F'Ilﬂ Edlt Fﬂrmat View Htip We are i‘” e i
| 'Fhf;:mg! 1*"6'_] Ad . Most
Ntw Ct”"N or e COAITE Frort Tray
L1z lar
New Window Ctri+ Shift+N e 1-6:3
Fortrat . g gt
Open... Ctri« O | 2 e = oo i e are
editor!
Save Ctrl+S ——
tut.:;ii wade 1 -64 L
1-9: MAS. cm#glmts - ':: e : pofreading
16 Dot » e (e ey = OK | Conce bow difficult
Pa ge Setu up... 12 {3 ST TR SISy waraewd Product ive,
Print... Ctri+ P
Bxit
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1-7: Print{CTRL + P}.
6xb Ol . ($395 O CurogsS 2 g 15 gl (550 CEEE
0)9€ 3idyy 5208) L= E52S VOS> LuSy Subily oJoS Lz 3 4E5)Se SIS
oJoS Oz 3 gl £6)S U515 0)uadds IS 3 JsS Lz IS 5 diwg)g L u_s}S
1-8: Exit(ALT+F4). (5259 SulS o)L

o)l 9lgais S o)l 9lgaiy 5 piSg 2w Dgi Jlemiwl 5 JilaS olig 5

7 “Untited - Notepac NOTEPAD SHORTCUT KEYS LIST: SxS Jo)S

File Edt Format View Help <514 -
- LD d0 O
. Cerle N Ctrl +Z: undo Jish) b Lilg> &y - g
. F1: Open the Microsoft help option for Notepad.
New Window Ctri+ Shift+N 2 593 3 0yl gino Liwye Gadlwg il Iy (5)S o>
Open... Ctrle O FS: To insert the current time and date. a)LJ oJol5 1) giloglas gl g L_,.uug'l 3

Save Ctrl+ S Alt + E: Open Edit menu. QLD L) ) 6)5 L)a)l_)

Save As... Ctrl+ Shift+S Alt + F: Open File menu. giwo L9 ._S)S o> NOtepad 2:Eating

Alt + H: Open Help menu. 9440 (han) )0 1) 6)5 o>

Page Setup...
17 Dimt_ Ctrle P Alt + O: Open Format menu. gixo JSub U et 1 6)5 =) £
Alt + V: Open View menu. giwo 2 13 (5,5 Lol

Ctrl + Tab: To give space between text., JoS)q 55> &in )5 (yio 3

Notepad 2:Eating cutscicopy vt g st

for zoom in. Ctrl + A: Select all the text or characters on the page. L5)5 oLl s el
Ctrl +V: Paste JsS o) 4o 55 L8 B (b d Ologlas &5

Del. Delete JoS S)9 L o) Dloglas

7| Untitled - Notepad
?File Format View Help

Ctrl ~ F or F3: Open the text Find dialog box. (S35 w5 LusSy Sglb) glaigs (yin o
Ctrl + H: Open the text Replace dialog box.{$)S o> LuSH Sglb) gledu (i o

- ! . 3
Ctrl + I: To give space between the text. )95 )5 (S5 zxio )3 (e 0

Paste
Velete Del Ctrl +X: cut J9S SH L d9-‘5 W0 D

Ctrl + N: Open a new note in the same window. d>0.0 di)g (§9) M g 13 (55 LB
Find. H ”

Ctrl + Shift + N: Open a new note in a new window. d>0.0 (§o) Jw gl 1D (6)S (A5
binct Nt ~ - z

Ctrl + P: Open the Print dialog box. ¢)lJ Ol> 2.0 15 0w i 1o (6)S Lo

Replace...

Ctrl + S: To Save the note. ..;;)5 o Sl J—D

Ctrl + Shift + S: Open the Save dialog box so that you can browse a file location to
SIS ) ding)g S i) A
save the note. Ctrl + W: Close the Notepad window. ¢S 3 glivg Jw gl

)lSW.:;LJA.C-lJ Wd&g|ggljg$q9)bg.wuﬁ)ﬁd5
S G Ol 9 LISILD olgi 13 o5 (59

3-Notepad format menu{ALT + O}.
3-1. Word Wrap.

S5 Jo)BS 0yl 934 (e 3 S a Dgi ) Ay 9J9S JgxSuw 3 ) )9 2
Oio Jgd G G195 9wl 93 .59 Oloy 229 S 2l ez @ w gunliw &S
O 0y 99 ) ) 99 3 185959 0)w 9l)S 4 ) )9 3 S PR

90959 42 9J9S JgrSuw dl 15 9. IS yg0 dlol (G0 d .5, disiui

- Notepad

View Help

v Word Wrap
Font..,

Select All
Time/Date

( Page 226



3-2. Font.
o)l oJod o hliw Cigd 3 aiw 5 wileS(JSub b Jliw 999)>)aig9
L G999 3 @uw 0puw 9> > 3 L g5 9wl 0puw (S (545 J9)S

e T LS)S JN )9l 9l pgl Kdg9 3« S5) dg9 3« o)Al S)9”
aaaaaaaaaaaaa gold [
Weagnate Bold Ob]igue - =
e

Semgh Notepad .

= mTyex :m'.';nét'] View Help . 4_N0tepad VIeW menu Or

"} ¥ Word Wrap : « A LT + V »

Font...

s a59d19-9)u—cu-v9)9->u>415«5)~'u9ww9m6)|9-‘)h~>| g
ClJ.LJS)S.hJ.U.)g.A.ULuJJClJLU)DngJ L_gngLQS)u_chlSpug_)@
M@Mﬁwwywwwbywo)l&wébwm

| TutorialPandit - Notepad o e ﬂ LS)J LA.LQ_QQ-D CL’ }-L> US
File Edit Formlat View | Help 5 NOtepad hEl_p menu
TutorialPandit Status Bar :
i (ALT + H}
5-1=View Help

0)ld 2 93 3 9555 (534S J9)US lgxd jeaing CdlngySole 5 diw o a4
o> 1o gl diwyo 39290 0)ld dd D193 3 .(5)959 PNo gl iwyo 39290
919)5 2 93 3 L (95 9wl ()2 A iwpo M 93 3 .83 )9iS

0)l ) 6Jg)lS dS93 douw ) Jw g I U guwls USLSAJ £625 03) G9S5)>
5-2=About Notepad. SrS Jg

S -S5x45 JBS 0)ld 939y 0)l 4y 2y Digi 3 JileS 0yl 4 M 9 D
‘MH@WQ@J%-g_s;)«oibwldgwimgcpgisdgsdefls
' | SH Vg Dlegleo o)l 4y )9 gl (5> >0

Notepad++ program.
A5 @ (Cudo Cudo) Guly pudy 20 g
A0 55 2 D193 L 95 00 al)Sg )
939)394405 j9Midg A I 293.03 A5 (25
LS.,;) B (S- L.AJl 0.5 Lw 9]95 L__S*”9-> 0 D uS
Qi 3 20 95 (595 )L 1o gl (S
55 153o 925 6053 alxSa 3 10puw 99l Sl
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Control panel windows 7.

oo 9iluys Caline @iwuw 3igaunS olol> 7 joxing 5 Jiw JopiS o

3 0)l) 9lgS @udais 93lidiyi joaing 5 1 dlol (S0 d) . (558 Jo)lS o)L

2E |l Aol i GIgS gwli v 0y 9lo)lS dy (535 .59 S0 HilaS
Olodaid pgn)ld 3 ¢5)S Ja Wlerdaid g 9‘@;34.3 3¢ E5)S o)
965599)15 52 (53 L)l S81)S 91 Sy J9piiS 5 1.86)S 05U ol {595
Q igi>g (S (599 525 )l (59l ol Wloudais (595)9 o) > &5
USg.laJl).wd.) 9J9.u.u.)|u.l.;o| ) USQJW UJLJ..LQ.C o.\o)Sbulw.ug
i ililoc gl gigSliiuige 3 dlidy (590 OF SHZ <SS JNgo

B 535S J9)lS 0) g8 @ubais
What is the history of Control Panel?

N0, axlg 3 Mol Jiw JoyiiS 2 855 & )b Jiw JogriuS o

1940 5 gl 651348235 50 9ls 0yl 9399)93 Kby 5 S 999 xigusnS g2x09) 4
$208) 3 2 i Jul ol H)liw GuSgp5 (S 030m) 1980 4y .08 Jo)
ol 9igaliniil SulS 03 3 xS S (2 ylsiwl Guadydil (Sigg)lS S48l)S

Jul S 1984 ¢y.J)S JoyisS iluwiyi 999,18 5 lgzx) 9>l yusio
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2 Easy Ways to Open Control Panel in Windows 7
Way 1. Use the Start Menu:1. Click or tap the Start icon at

pottom left corner of the desktop. This Is to open Start
menu.:2. Click Control Panel in the start menu.

Way 2: Open Control Panel Using the Run Window

1. Press Win+R (Windows logo key and R key) at the same
time. A Run dialog box will appear.:2. Type control in the
run box and click OK button. e
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1:System and Security 2:Network and Internet 3:Hardware
and Sound 4:Programs 5:User Accounts 6:Appearance and
Personalization 7:Clock and Region 8:Ease of access
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Adjust your computer’s settings
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Virus protection (Important)

Windows did not find antivirus sof
computer.
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Action center,2:{User Account Control settings}.
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2:Memory (RAM).
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5-2:Check to see if the problem is fixed.
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1:Startup Repair,2:System Restore,3:Complete S 09>
PC Restore or System Image Recovery,4:Windows

Memory Diagnostic Tool,5:Command Prompt

~ Action center ,/:Backup and restore.
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Step 1.Click Set up backup.
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Step 4. Set the Backup Schedule.
Change schedule.
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3: where do want to restore your files?
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4: Additional clock.
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. Windows 7 Account Types
1:Standard User,2:Administrator,3:Guest Accounts
1:Standard User.
i 3 9l (59)89 giolw ($19 L LoS LS9 Ll (5)lues 3

LgQSCU O)J..C' L_/\J.LO')JQMAS.) lJ USJgg)lS)gJ L_,.> LS)S J.)u L_JLQJ.I:DJJ
2:Administrator.

Cellao Jgo 2 i oS gl (s wpwd iy & HiguaeS Gl
Q 455 gilpae d v pulwly gilewdaid Wiys 5 .(5)S disduel) digigly
Vgign) 52§V S0 (525 ($3h9 2U b poiiy Ju> 2 o0 Jiubgly

($9S 0)4<| u5399)15 )P 2 (SP9
3:Guest Accounts.

QJLGAMHMJU>6)0)UQSJ>QQ_QJL,SJ.@|QJQJ9JLA>9M
o2 (59 (SNg> o)l 5S399)1S 920 3 b Ll 330 3.5y L)l 45 Lig)LS
dJ939J9J-wy@pwmwdydpglsﬂmwowwwgJ

3 Ol )8 (sx09) S 7 H9xg U (S 93)lg0 (519 V.595)9 0) >
SH o) ol 45> )2 JUS7)9,w9cU Ol 1 .60 Llws pawo

Open the User account(change your password).
oD XS)HS> Ay OS5 92 9l 85259 SdS (3L LS glgd pgisy Ju> 0
9l 525 433 jo) iuwgl Ji> 2)908 b j0) ($93 & 95 9l 2 2
agiiy 3 gl > dIS .g5)loe Jo)l5 () sl 2 ¢5)S J>1o (s asn Ly
5929 3 guolinw . £5)S9 SulS 5 ol yaub 5 «awly gioz 4 gl
J9riiS ol H)Sw Ol U)‘S 3 {40 195 stL' ol So JN Lol 35wl
e (55 2 i

| FI'I"r';'l r.‘nf_‘l Flr:-f"'lf . B ) [ -.I“||_-.||Ir1_ I DRSSO ‘I_
AGKe Changes 10 your uséer account
".r'l"lfl]' e T g [ TG tach
Lréste & piisvedid Rl Stk les ! , I Searchard vner
= - u' Haywaord Fln‘!rrfr:'
Lk anlee Kx .' Standerd user e
g e U s..‘ Password protected
'h‘:-'l.'-_i-r somi? libe e cryphon it szt
2 . LaTul - T T bl &l Rk
CETr o &= ‘. | i e
¥ [} 1 5 mt E i
Conligure adven ed uier -" : i i [l
Felie properiees ¥ your pispsword contass capetal lettery Bwry mutd be Bpped the 1ame way every bme you log an

<<L§)S CU9 =) Ub JO <8 alim O)L,LJ CRVITISR d) u>9-'0 1O»
{ s yolelusd}

Page 240
< 9Qs




User account(Remove your password).
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Create a new account
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User account Delete the account.
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Control panel Personalization.
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Open the sounds windows 7.
($25 SIS (s35L Gl (5353 L 9l 95 o> Huanlaighn guwli (> dlS)o
1-1 Sounds and playback to Conﬂgure
2< b jlol )Suuwdg) yigaraS Jus 15 2 b (535S gunli (s33b (il (50 4
e = 4 (595, WSaudg) igasaS gl G2 A 9 poles

N || EesiadsncuniN 1-2: Playback properties.
\ & ' / \ o2 LW (5295 9wl S Guwl
0 JSuis b (S5les)S J2 o pos
=1 00 9wl dillsesgli b (5395 gz
== 5355 035 b Gyl (5B

D (S35 e, u“-‘(QQL539S)|)SL’A9J)-Cu>u“’L539SPQ9| (A0 @D
6395(359| UMLJQJQJQ»LSBL‘S-“ULSQW)-CUSWQUJQ-”U’
.;_h_:;_i.::f._ — L59‘3|9 BN | N L_>J|9->'-’ ) ) Ty L_,u.)

YDAk Recordng | Sounds | Communicabons

A__' ,,,,,,,,, 1-2:Sounds recordlng
S L Uuo .5395 9-1-'-‘L‘ US u-“-*-" S- "
T dbee Sdudanlbe el
S5 52 d 9 (59 Sz 2 b so
ccccccc S Y ug ug_gﬂ Q. U“, ULS d>>

69#-’Jl-9-9)J—C <6)59‘5015uMu56L>JL>43*4345uw13436l5
SlS L (999)Sale 2B (soub Jled 1u93)Sg SS gaguis ghling
0999)3o 0y duid S>3 1L gwli gl . £6)59 SulS £5)S Jleo <fs)Sg
U (S94D 0)9€ )0 « (59 Juog 0w L2dlg (1599)Sule guwliw aS' L ¢5)959
Cad 3 )999)0be 15 Cinlgd )yl 9555 ¢62S 0)9€ 15 o (JgS gwli o3 « (S5
o)l 6J9gS i 5 H999)Sule Ay 2 st S5 guwli a5 .(59)89 0)l olgS
{5259 ‘-i‘-lsn‘ué-’ Gl G 3 9l €635 0)9€ (H999)S0lo i J9) 9

LJT!99 ?gﬁ v i:““drft
- Page 246
002




1-3: Sound and sounds.
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Color management and Advanced.
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Finish and the click on the Turn on clear type.
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Update driver.
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Devices and printers and the Add a device.
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dlg Wlogles g L_g).l s (63 Lhg S s (133)ay yoo lgie |
o2 X ey 62913 .6) "3Sx0 o 3" 5 iy JoriiS" 7 jeiag
NiousoS 9553 (595 diaw o > 99990 ilagdais jigaraS 3 guwlion ) gl
GS3inn S ()Saw 4 i GIgS sl «dSei 4y Jlio 5 .59 Bl Jo)8
619) S yigusaS Ay Sygo 3 i oS 9wl gl 5)S dilwl 0)ld glad o

Page 260
_a0Qs




Ou0iSa0 0y N2 G Sz 4 gluwg ple 135)S 03 LIgS5)>

- me LS)S Juo ousSen 1) ol SSgily 19)9uS HaxSaw
swe o Ease of Access center and the make.

== .- | the keyboard easier to ues.

R r———— )9S 52 LW ($395 g0 uS O S- 4

i e de eSS Old gl sy )18 puge axs

1:(?) Turn on mouse keys. %= Sili o0 2 4dsS U

LS)UCU Lo 9| 69).'9 dodc LS)LOLSJ.,)LS.\JL) u.uu| dc) g.quJ CL))DdS
S Lwge 13 a3 3)9uS Jub 2 b (535S sl 9 (5)S SulS (puinl
S8 diyb ) gigi (5)lasd 2)9uS 13 b o pos) (S2S 9w

1-1:(?)Turn on Mouse Keys with left Alt+ left shift+Num.
locK.

010 ($)9) (25 3 S S5y90 3 2 D ($B9S 9wl 9 (525 S G
&ﬁﬁpwwipwwlgjglwldmu@ gpQﬁb

1-2:(?)Display a warning message When turnlng a setlng on.

L_g)l.)|'~'1l.)l.4.)9| 69).'9 CLo)LCLS)l.og_S..;.JLS.\JL) u.u.u| dc ) g.u.)b Cl.))4.>cl5
wbyﬁdé)éel&uwwbyuwsiﬁwby&ﬁd*lfuw|

U})g)ﬂdJHASg,JLuJ |..)ClJ)S).o L_J.u.))u.)j
1-3:(?)Make a sound when tyrning a setting on or of. f

L5>bl dJ l.u 9| 69).'9 dodc LS)LO LSJ.,) LS.\J[J L)'"”"Ul dc) g.u.\b d.)).o dS
S (53553 jlol L uwswdb wbyuwsﬂﬁgwb ydzfd*ﬁuaw'

2 Chek on

Page 201




1-4:(?)Pointer speed.
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4-0: Turn on filter keys and the Set up filter keys.

4-1:(?) Turn on Filter Keys when right SHIFT Is pressed for 8
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4-5:(?)Beep when keys are pressed or accepted.
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6:(?)Prevent windows from being automatically arranged.
when moved to the edge of the screen.
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(?)Make It easler to focus on tasks.
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25: Control panel and Getting started.
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(25-6)Add new users to your computer.
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28: Control panel and keyboard.
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(30-2)Manage wireless networks.

SdiS 0)0 635 (S (Slg 95 940U (52 (595 0)8uw 90l S Gl ($3 4
(30-3)Change adapter settings. b (5gub
SiiS o) Sb (Slg Joo poS swli 2 (595 0)Sub guwli gl (53 4
03 SL slg id dedgs 9l (SL (sl did () 92 (53 g 095 W [ gl ¢l

(30-4)Change advanced sharingsettings.
&MUwg&wbdﬁywkSigngbuSuw|dJm
gséuidwydéo)&ubs«wusw»&»

6k o d infernet 3 Network and Sharng Certer

"
i ! i
& o 0 = e Ciree Fare ey aad g et Hartenirh 2] 0 vn) Lerd o inaned Sl vu) T 0gn - 0
AUN PC Metwork \ — > R R s
i £ ermpeder Fis Lis Vs 1
v 5O & sd LA : .
" ol s T 17w o 11 | Pt i i
- W L W e R e el e Y e - a3 ¥ & L w ey F oo 1
S J Network 4 Accem hpe I-te—wt o = et
L
™ : Connactions B 1 - —— , O n rO a n e a n
i _ B e ®
L ]
ce SRR ol ] - 5 P - a4 [ il T el Bl b ri el il et 0
i | = it TRy 1 iy - ] o | by

S B =¥

; = B Pl e ’ i L
- LT [ e — L . .

bt up & wwparid broadbesd dal up 0d hed o VPN {eenasben o ael up B el & 8L E

rt"l"! de gl g ord p Ty

Sy ¥ P s L L - . il P Pl b el "2
; " EET I L O E T o
. ar T oy e -_—
L orwwect or reconnect o 8 wemlert weed dad g or VrlM artecs cornechon e ':_ ...--1.. b
e L

! [ g Ity ' L]
. T g iy e s Wemhs il Py oy i g Boia F s Maj-i B
A s i Yy pnd preatee) g dled on gther netacd (amputen o (hange thareg weitangl i s il el il . Bl v A, i i et PPl il i
. . " . - Fnle e Tagiand Loy . [ g N
- T ST w0y = - B dewasT & s i
gres wll i Tl e T aag Mgl g e Leeupan
-} . ®
I - -

1531 03 uSawli 3 Lo L (69 Lhis LS Ao (120)4y yg0 pinl 1
535 0oN5 by iy (53 HLSuwly 4 BigelySysy Lz b (5HoS 03

r— y* -
- " L Taskbar and Start Meny Properties —r—
8g AutoPlay B¢ BitLocker D: — 2
Taskbor  SuwtMeny | Tookwrs > P
B Credential Manager Date and Tu . '
stk Ao arce

20k e taskbay
L B BT
@ Ease of Access Center \g Family Safed _we sl core P o

] (]

Pt OO0 %00 OF T 0w St

350 Fidvyer j DA T ;*||_ W s
" achua Ba =t eyt CODerel, Pehe s W w—
"; HMomelLroup = indeang O '
(e o

-lq “eatcaton aes I T —

- heyboard ¥ Language Befow QRN w0 s Customuze which cons and netficatons appes 1 e .
-_— A 1 + it alr yea ““‘5
L __au gn s g mame s Start Tash Manager
i Mail (Microsoft Outiook 2016 ¥ Mouse e e JEETOE w1 Aer i Pees
il
| = b VB Larik bar Tempo iy vew the :--:-m. T PR DR PO PpUaE TD e
1 an Fow .h-:.lu.::-"q.. B af erd o T LB
Prepartied
S, Y e Aere Peek o prevew B deshiiop

32: Control panel and Parental control.
Cogras> JoyiS g dlg 3 05 JlaS )5 (59 GigSlHlign e 1
3 SDB (2599 2 99901)S9)) 42 gl NigaiaS 3 giloguilo 5 gunlin

‘cu.la.u ng.u.)g..\:uo Ca>g J.00 d.LuJJg dSLa.‘.uJ)ﬂ O)U 9J95 dg),p.s
615 J9riiS pUx ol (9} (B9 yigaaS (599 3 Lib LS sunlinis)S

=y
v
=S E .
- Q v/« Pare. » Game Rate - by - e

)—:’, E"‘I.‘j[":l' "H._; C;}tiorg GQ! & « Parentsl Contrels » User Controls v | 4y ! M

ﬂ CERO L EEguier | nog e howtpal Faen g Lorgaenig i e
t tha LI 14

L]
1 D ' 1 | Sot up how Littlegeek wi & TNe COMDUt e
¥ ijl £ ) i . L i BN b e 2 . 3
o < - TRrese LCormgutnr Softearr Satng Regudahor
. Farertal C ordmply Current Sethng Cavpier baftoran 5 i J .
B sy B g o s ' -

@ On enforce curment pettings

i & . | Littlegeex
;ﬁl-i Tt1r-‘iT|]| { [_\|'-1r":_=i|; w ‘.:H‘d-‘l” ."-H EHRB “ {W*HF"F'“*“! ';'-*'i',.-r' 'r.-g Hr Flﬂ
q 4 = Sl - 2 r
= " Weadoes Seftngs - 8 4 protectes »

;l) -mz In-* | st " ‘- + Teme Lavs " : B
" "y i | o ek et e oo et . Barrve Bt -l
< ‘1' - foj wmrase © Game Ratng

|« Programs and Features D o Game Ratings
- A

& Lonbol gaeees by refengy, content, o bible Progresn Larwh f
I""" ..d.._.,,_."'. et of Bdeny s L ettt L sl 2 D
' : A L v the OF sbcibe
C h D ' b ascul™pd dlock sy pragrams en your computes | ~m—
Speech Re .

cogn Lon
P d. 2a= | urepes= Lame Momaten

m T
o P RN

X8  User Accounts
3

Page 270
90z




33: Control panel and phone and modem.
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41: Control panel and internet option.
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44-2) Change notification settings-turn windows firewall.
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